
How to Format Your Dissertation or 
Thesis at the UW  

  

 

 

 

Written by D. Gleason  
 
 
 
 

Center for Social Science Computation & Research 110 
Savery Hall University of Washington Seattle, WA 

98195 U.S.A (206)543-8110  
April 2013  

 
 
 
 

 

 

 

 

 

 

 

http://julius.csscr.washington.edu/pdf/formatdiss.pdf 
  



CSSCR  formatdiss dg april 2013 Page 1 

How to Format Your Dissertation or Thesis at the UW  
The University of Washington Graduate School Guidelines have been simplified and your dissertation/thesis 
will be published electronically. You must conform to the Grad School’s requirements for the preliminary 
pages, page numbering, page order and final pages. The publishing entity, ProQuest, requires you to submit 
your paper as a PDF. Your department might have a preferred style, but otherwise you’re on your own.  

Fear not! The following information should help you format your Life’s Work with ease and grace.  

Back up your Files  
To most of you, this is not fresh news. Diversify your media; print out your chapter drafts, especially if you are 
switching computers a lot. Send your files to your email account if your primary storage is portable memory or 
hard drive. It’s hard for me to judge just how often you need to do a total backup; if you have no resident 
computer, and only work from removable storage, copy your file(s) to your server account with every work 
session. That way if you fall off your skateboard and smash your flash drive to smithereens, you’re covered. If 
you work from a stable, private computer, perhaps you should do a print-out and “other media” backup every 
chapter.  

And here I would like to say a word about file names: Simplify. I sat with a client once who was having trouble 
with his footnotes. He had the file on portable memory, but his naming system was so arcane he had to look at 
all fifteen files before he found the correct one. Naming files “ch1v1, ch1v2, ch1v3” seems logical, except that 
one brilliant bit of analysis you made back in an earlier version--which was that again? It might be simpler to 
keep only two versions electronically, and keep paper copies of the more minute revisions. And also, keep a file 
which only contains your tables and illustrations and graphs. Or several, if your paper has a lot of 
photos/complex charts. That way, if you accidentally delete a graphic in your working chapter, you can always 
snag it from the graphics-only file. If your paper is very long (over 300 pages) or graphics-intensive (an 
illustration, chart or photo every other page) split it up into different files. It’s a bit of a job to do page number 
continuity when you’re ready to make the final copy, but it’s a much larger job to recreate your deathless prose 
if your gigantic file blows up.  

Styles  
A style is a collection of instructions, stored in a paragraph mark, (and/or a style catalog) which delineates how 
your paragraph is arranged on the page, and what font specifications you have chosen. Every time you hit the 
enter (or return) key when you are typing text, you are copying the just-written paragraph’s instructions into a 
new, blank paragraph. The preceding two sentences will be important later on. Maybe you’d like to read them 
again. 

In almost all word processing programs, there is a little box in a toolbar which displays the style of the 
paragraph your cursor is in. It may say “body text” or “footnote” or “page number.” In MS Word, you can’t 
modify or delete these standard styles (which seems pretty high-handed to me), but you can make new ones. 
Once you have created a custom style, you can apply it to other text in that file, export that custom style to 
other documents, and best of all, if you need to re-format the style, every paragraph tagged with that style will 
change! Automagically!  
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HOW TO CREATE A CUSTOM STYLE IN MICROSOFT WORD 

% Format the chosen text with the font and paragraph choices. Here’s a style for an extended quote: Font: 
Times New Roman, 12 pt Paragraph: flush left, Normal + Indent: Left 0.63 Right 0.63, Space before 6 pt 
after 6pt.  

% Now highlight the entire paragraph (including the very important paragraph mark) and right-click the 
selection, go to Styles/Save Selection as a New Quick Style. 

% In the “Name:” box, give your new style a descriptive name. If you are making a bunch of styles that you 
want to use a lot, give them names like “1-hanging bullet” and “2-space before.” These styles will appear at 
the top of the style list, and you don’t have to wade through a bunch of undelete-able, useless standard 
styles to get to the good stuff.  

% Click on OK, and you’re done.  

HOW TO MOVE CUSTOM STYLES TO A NEW DOCUMENT  

4 On the Home tab, click on Styles to open the Style pane.  

4 Click on Manage Styles; click on the Import/Export button.Your current document’s styles should be 
displayed in the left-hand box. In the right-hand box, the “styles available in:” should be the Normal 
(global template). 

4 Click on the right-hand Close File button. It should change to an Open File button. 

4 Click on this button, and an “Open” dialog box should appear.  

4 In the “Files of Type” box, choose “All Word Documents.”  

4 Now find the file from which you wish to copy styles. 

4 Click the Open button. And you’re back to the Manage Styles (or Organizer) dialog box.  

4 Highlight the styles you want to copy and click on the Copy button. 

4 When you’ve copied all the styles, click on the Close button. 

4 Now would be a good time to save this file.  

Space Between vs. Empty Paragraph  
Remember those two sentences in the previous section I said were very important? Here’s a slightly different 
view. The paragraph mark contains all the formatting for the paragraph which is in front of it. When you finish 
a paragraph and hit the enter (or return) key, you are copying all of that information into a new paragraph. If 
you don’t write anything in that paragraph, the information is unused, but there nonetheless. 

One of the reasons footnotes in Microsoft Word go astray is all the empty paragraphs people use when 
composing. Use Space Before/After to make space between your paragraphs. Delete those empty paragraphs, 
and go to:  

6 Paragraph/Indents and Spacing tab.  

6 Then in the Spacing: box, set the width of the space which will separate your paragraph from the one 
previous to it. (Or Space After, if you prefer. I use Space Before because I have a button on my toolbar 
which adds/subtracts space before the paragraph.) 

6 Click on OK. Now, every subsequent paragraph will have six points of space either in front of or behind it. 
And you can incorporate this new way to separate paragraphs into your custom styles, as well. 
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Why you should turn your Blessed non-printing symbols on.  
Hey, here’s a space!   And here’s another!   And yet again,        a space!  
Looking at the three spaces above, can you tell which one is an indent, which one is a tab, and which one is me 
hitting the space bar a bunch of times? Nope, you can’t. And that’s why you should have your non-printing 
symbols turned on while you are formatting. I have mine turned on all the time, but I have heard that it is very 
distracting for some people while they are composing. If you have your non-printing symbols turned on, you 
can see that the jagged-edged two-column comparison you made five drafts ago was created with multiple tabs. 
You correct that in compa different manner than if you had created it with table cells or the side-by-side column 
option. And when you are taking out empty paragraphs, you need to be able to see them.  

TO TURN ON YOUR NON-PRINTING SYMBOLS IN MICROSOFT WORD:  

$ Go to the paragraph toolbar and click on the button with the paragraph mark, which looks like this:  ¶ 

$ It is called Show/Hide.  

$ Alternatively: ) Go to Word/Preferences/View ) In the Nonprinting Characters section, click on the box 
called “All.” 

And while I’m at it, block style vs. indented style.  
Block style is more aesthetically pleasing, is less fatiguing to read, and is much easier to write. Be sure and leave 
a little bit of white space between each paragraph. I usually have Space Before set to 24 points if my text is 
double-spaced, twelve-point type. If you’ve already indented, don’t worry! There’s no need to take them out.  

Margins  
You probably already know this, but:  

TO CHANGE MARGINS IN MICROSOFT WORD .  
Go to the Page Layout Tab/Margins/Custom . Set all margins to 1.00 inch. In the layout tab, in the Headers & 
Footers section, set the header and footer to half an inch from the edge.  

Headers and footers  
A header is bit of text which runs from page to page, varying only by section. Sections wall off chunks of your 
file so you can format them discretely. Unless you want to break your documents into three files, you will use 
section breaks to create your two sets of page numbers, plus the unnumbered pages at the front of your paper.  

To make a section break, go to the Page Layout tab/Page Setup Group/Breaks symbol. Choose Next Page.  
And now is the time when I tell you about the inexplicable and evil “Same as Previous” function. “Same as 
Previous” means “this section that you are formatting now is going to be the same as the section just before it,” 
and is the default for headers and footers in MS Word. This means that after you have gone to the trouble of 
walling off pieces of your document so that you can assign different headers and footers, Word has pre-decided 
that you must want the SAME headers and footers across ALL sections. Which you do not. If you had 
boatloads of sections and no page number changes, this would be ok, but in the case of dissertation/thesis 
formatting, it is a big mess. This is why I format the page numbers from the last section to the first section, 
rather than first to last. Then I can click off the “Same as Previous” button right away, before I even place my 
page number. That way, I am not affecting the other sections.  
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To turn off “Same as Previous,” put the cursor in the header navigation group, click the “Same as Previous” 
button to turn it off. Once you have your section breaks in, put your page numbers in the header (or footer, if 
applicable).  

^ Go to the Insert tab/Header & Footer panel.  

^ Edit header  

^ Page number/top of page  

^ Choose the page number orientation  

^ Format page number  

^ In the Start At: box, type the number you want this file to use as the first page number. Click on OK, and go 
back to the Header & Footer view.  

^ Click on Show Next to page through your  sections and ensure that all sections are numbered consecutively.  

^ If you have separated your paper into different files, use the Start At: box to number your files. Your second 
file (mysecondthesisfile.docx) might end on page 260, so your third file (mythirdthesisfile.docx) should start 
on page 261.  

To put a page number in the footer, go to the footer and click to place your small Roman number. You might 
like to use the “Go to Footer” button for this. It toggles between the header and footer. Before you close the 
header/footer view, make sure you don’t have extra paragraph marks in any of your header or footer sections; 
this could make your page numbers inconsistently positioned from page to page. Double-click in the grayed-out 
text to get back to your document window.  

Aaaand don’t forget to save the file(s).  

Use the hanging indent! For Goodness’ sake, use the hanging indent!  
When making a numbered list, you usually hang the number. That means the number is up against the margin. 
The first line of text begins a few spaces in from the margin. Every subsequent line starts several spaces in from 
the margin also. The creates a tidy block of text and leaves the number hanging by itself. Again, probably you 
know this. But you might not know that it’s good form to hang punctuation on an extended quote, as in:  

“The newspaper industry is in trouble. The decline can be traced back to 1960, when The Reporter 
Dispatch in Westchester County, N.Y., made the suicidal mistake of letting me deliver it. I was 
terrible  at this job. I was always late, and I could not get the hang of folding the papers, so when 
I flung them  onto people's doorsteps, they looked like origami projects that had been 
regurgitated by wolves.”  

Notice the beginning quotation mark stands (visually) alone. You can do this by moving the bottom half of the 
left indent on the ruler over a few spaces. Then make it into a style, if you have many extended quotes. To turn 
on the ruler, go to the Office button/Word Options/Advanced/Display/Show vertical ruler. Click on the ugly 
non-intuitive symbol in the main document window, above the vertical window slider. Or under the View tab, 
in the Show/Hide panel, click on the ruler check box.  

Another place to employ a hanging indent is in your footnotes or endnotes.  

58.  A fundamental belief held by Americans is that if you are on land, you cannot be killed by a 
fish. This belief has been reinforced by the Steven Spielberg movies “Jaws,” “Jaws II,” “Jaws 
Goes to Porky’s” and “Saving Private Ryan From Jaws,” in which the only characters to die 
were the ones stupid enough to venture into the Atlantic Ocean, where even ankle-deep 
water often conceals predators the size of Winnebagos.  
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Again, make this a custom style, and you will only have to format it once. When you type a bullet or a number 
for a hanging indent, separate it from the item by a tab, not two spaces. A tab will always line up. Spaces used to 
make a hanging indent will NOT line up, unless you’re using the Courier font. Courier is a mono-spaced font, 
and almost all other fonts are proportionally spaced. That means that the spaces between letters are different 
sizes. Just make the tab and the hanging indent line up on the ruler and your first line will always match your 
succeeding lines.  

If you’re in a hurry, the Format Painter tool (little paintbrush on the left side under Home) copies your 
formatting, also. Be aware that my friend the paintbrush is somewhat limited; if you have two fonts in one 
paragraph, Paintbrush Pal will choose the first font and ignore the second one. 

Tables of Content and the People Who Love Them  
A lot of my really panicky questions come from people who have used Word’s “automatic” table of contents 
process and it hasn’t worked for them, in that scary my-deadline-is-noon-and-it’s-ten-am-now-what-do-I-do?! 
way. If your table of contents is a page or two, and your list of figures is less than a dozen entries long, it might 
be easier to write them manually.  

To write your table of contents by hand, type an entry, hit the tab key ONCE, type the page number, hit the 
return key. Type the next entry, tab, page number, lather, rinse, repeat, until you have them all written out. 
Now, highlight your entries. Go to the ruler, and click somewhere around 5.5 or 6 inches. If that’s not close 
enough to the edge of the paper, grab the tab (on the ruler; it looks like an arrow with a right angle) and drag it 
to the right. With the whole table of contents highlighted, go to Format/Tabs.  

 

If there are multiple tabs, clear them all except the one which 
is 5.8, or whatever the largest one is, that’s the one you made 
yourself. Highlight it. You also want a right-aligned tab, most 
of the time. Sometimes a right-aligned tab won’t line up, 
because of other formatting issues, but usually it will.  

In the “Leader” box, choose the dotted line (Choice # 2). 
Click ok. A tab leader is a tab which is a dotted or broken line, 
rather than a blank space. Use a tab leader when formatting 
your table of contents.  

 

 

 

Another very common question is, “Why don’t my page numbers line up at the right side?” This is often 
because the user has typed the table of contents by hand (good!) but has typed the period key over and over to 
get that dotted line which runs between the entry and the page number (uh, not so good.) See the paragraph 
about hanging indents and tabs, above. When the spaces between letters are different sizes, you won’t be able to 
line up the page numbers. In this case, I would take out the line of periods (series of ellipses?) and replace that 
line with a single tab. Then set the length of the tab and make it a dotted-line tab leader, as above. 
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The important place to have a clean edge is at the right and left margins. A sample entry:  

Chapter 5: The Emotional Significance of Imaginary Beings .......................................... Page 90  

If you have a really long entry, which wraps unpleasingly:  

Chapter 1: In Which We Discover That Children Have Really Great Imaginations, Who Knew? 
 ................................................................................................................................................. Page 7  

It might be nice to hang the entry under itself, and break the line in a prettier way. Use a line break rather than a 
paragraph mark to keep the formatting consistent. Hold down the shift key and then hit the return key to make 
a line break. Your entry looks like this if the line is broken right after “children”  

Chapter 1: In Which We Discover That Children  
Have Really Great Imaginations, Who Knew? .................................................................... Page 7  

Now, to line up the entry under itself and leave the Chapter title hanging, pull the bottom half of the left indent 
over until “Have” lines up under “In.”  

Chapter 1:  In Which We Discover That Children  
Have Really Great Imaginations, Who Knew? ............................................... Page 7  

If you have subheadings, I suggest indenting them instead of typing a tab. Then you don’t have to format each 
individual tab, because there’s only one per line. And of course you have figured out that you can make each 
heading and subheading a custom style.  

Chapter 5: The Emotional Significance of Imaginary Beings  ......................................... Page 90  

My Little Friend is Seven Feet Tall and Bright Green: Protectors ............. Page 112  

Just because, I will again mention: Now would be a good time to save your file.  

I hesitate to tell you because it’s so very elementary, but I would put off final formatting of the table of contents 
until you are really truly done writing. It’s great to have a rough outline with page numbers, especially if your 
paper is long and complex, but formatting all the headings and subheadings and pinning down the page 
numbers is less fraught if you do it when you’re completely finished with the composing and revising.  

Another Page Number Issue: Landscape graphic, portrait page number 
If you have a page which is oriented 11 x 8.5 (landscape) rather than 8.5 x 11 (portrait), you will need to make 
that page into its’ own section and put the page number into a text box. If you let Word continue the page 
numbering (Same as Previous, my old nemesis!), the page number will be on the end of the page, and sideways.  

 Put in section breaks before and after your special page 

 Go to Page Layout and change just this section from portrait to landscape 

 Go to header/footer view and disconnect the next section from the previous one, and start the page 
numbering appropriately. As in, if your special page is 47, start the subsequent page numbering at 48. 

 In your special page section, delete the page number. 

 Insert a text box, type the correct page number, then under Format Text direction, rotate the page number 
until it’s the same as all the other page numbers, and grab it by the frame and move it to the right location. 
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Diacritical marks, symbols and special characters  
To insert umlauts, accent marks, tildes, upside-down question marks, use the table below.  

INSERT AN INTERNATIONAL CHARACTER BY USING A SHORTCUT KEY  

To Produce  Press  

à è ì ò ù À Á Î Ó Ú  Control +”(accent grave) followed by the letter  

á é í ó ú Â É Ë Ï Ô  Control + ‘ (apostrophe) followed by the letter  

â ê î ô û „ ‰ È Ì Ò  Control + ^(circumflex) followed by the letter  

ã ñ õ Ã Ñ Õ  Control + ~ (tilde) followed by the letter  

ä ë ï ö ü ÿ Ä Ê Í Ö Ü Ÿ  Control + : (colon) followed by the letter  

å Å  Control + a or A  

ç Ç  Control + c or C  

¡ ¿  Control + !, Control + ? 

 ß  Control + s  

ø Ø  Control + o or O (that’s the letter o, not a zero)  

To insert special characters like em dashes, trademark symbols, ellipses; go to the Insert/Symbols/Special 
Characters tab. Highlight the character, then click on the insert button. If you’ve inserted it in the wrong place, 
worry not! Once it’s in your document, you can copy and paste it just like any other character.  

To insert a symbol (like a Greek letter), Go to the Insert tab/Symbol, and choose the symbol you need. 
Highlight it, click on Insert, click on Close. If you want to insert certain characters over and over again, you can 
assign them shortcut keys by clicking on the “Shortcut keys...” button.  

Objects (inserting vs. cutting and pasting)  
You can cut and paste graphics and text into your primary file. This often works. When it doesn’t, try the Insert 
menu. You can insert a picture (usually a pict, jpeg, gif or other graphics file) an object (an Excel chart, an SPSS 
graph) or a file.  

HOW TO INSERT AN OBJECT, AND LINK TO IT, TOO. 

4 Put the insertion point where you want to insert the object 

4 Go to Insert tab, in the text group, and choose the Insert Object button.  

4 Click on the “Create from File” tab  

4 Click on the “Link to File” box 

4 In the “Browse” dialog box, search for the file your object is in 

4 Click on Insert, then OK.  

When an object is linked, you can edit it in the source file, then update it in the Word file. This seems like more 
work than editing it in Word, but your object will have a smoother appearance, and you will be far less 
frustrated, if you update in this manner.   
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CONVERTING FOOTNOTES TO END NOTES 

 Go to Draft View/References 

 Open the Footnote & End note dialogue box 

 Click on the Convert button 

 Choose “Convert all footnotes to end notes” 

 Close.  

FOOTNOTE/END NOTE SEPARATOR; HOW TO GET RID OF IT.  
There’s a black line that Word uses to delineate footnotes from the body of your paper. If you want to change 
or get rid of this line, do this:  

 Go to Draft View 

 Choose the References pane  

 Go to the Footnote and Endnote dialog box  

 Choose “Footnote Separator” from the drop-down menu, and you’ll see the separator in the pane below 
the menu. You can delete or change the line from here.   

Other Writing Software Options 
There’s no reason for you to use MS Word from start to finish on your publication.  
Bean (http://www.bean-osx.com/Bean.html), Omm Writer (http://www.ommwriter.com/) and  
Dark Room (http://www.bean-osx.com/Bean.html) are austere, no-distractions programs; easy to focus on 
your words without any bells and whistles. Ulysses (http://www.the-soulmen.com/ulysses/) and  
Atlantis (http://www.atlantiswordprocessor.com/en/) are packed full of good features with the added 
attraction of being cross-platform compatible and Atlantis particularly converts to e-pub format fairly easily.  

 

You can E-mail me at ascocarp@u.washington.edu, or call 206-543-8110.  
I’m in 112 Savery, Monday through Thursday, 8:00AM to NOON.  
Best of luck in your Academic Adventure ™ !!! 
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(from the UW Graduate School site) 
Format Guidelines for Theses and Dissertations 
Margins 
Page numbers should be .5 inches from the edge of the paper; the margins for your text should be one inch or more.  

Page Order and Numbering of Pages 
Order and number the parts of your document by following the tables below. 

Un-Numbered Pages 

The initial 4 or 5 pages in your document are not numbered. 

Page / Section Optional / Required in document 
Title Page Required 
Copyright Page Recommended (Required if paying dissertation copyright fee) 
Abstract Required for dissertation, Optional for Master's Thesis 

Numbered Pages 
Each of the following pages must have a page number, including the first page of each chapter or main section. If using double 
sided format, make sure your page numbering is on the outside (not bound side) of the page. 

Preliminary Pages: Lower case Roman numerals centered no less than .50" from the bottom of the page 

Page / Section Optional / Required in document 
Table of Contents Strongly Recommended 
List of Figures Strongly Recommended if document contains figures 
List of Tables Strongly Recommended if document contains tables 
Glossary/Index* Optional 
Preface Optional 
Acknowledgements Optional 
Dedication Optional 

Main Text: Arabic numerals no less than .50" from top (centered or right); Begin with arabic numeral 1 (do not count un-
numbered and preliminary pages) 

Page / Section Optional / Required in document 
Introduction Optional 
Chapters/Sections Required 

Final Pages: Arabic numerals no less than .50" from top (centered or right) 

Page / Section Optional / Required in document 
End Notes Optional 
Bibliography/List of References Required 
Appendices Optional 

Vita 

Required for dissertation 
Not accepted for Master's Thesis 

*May be located here OR in the Final Pages, before the Bibliography/List of References.  
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[Title of your document] 

[Your name] 

 

A dissertation 

submitted in partial fulfillment of the 

requirements for the degree of 

[Name of Degree] 

 

University of Washington 

[Year (no day or month) of graduation] 

 

Reading Committee: 

[Name of reading committee chair],Chair 

[Name of committee member] 

[Name of committee member] 

 

Program Authorized to Offer Degree: 

[Name of program] 
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[Title of your document] 

[Your name] 

 

A thesis 
submitted in partial fulfillment of the 

requirements for the degree of 

 

[Name of Degree] 

 

University of Washington 

[Year (no day or month) of graduation] 

 

Committee: 
[Name of committee member] 

[Name of committee member] 

 

Program Authorized to Offer Degree: 
[Name of program]  
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Sample Copyright Page 
 

©Copyright [Year] 

[Your name as it appears on your Title Page] 
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Sample Abstract 
 

University of Washington  

Abstract  

 

[Title of your thesis/dissertation]  

 
[Your name as it appears in official UW records]  

 

Chair of the Supervisory Committee:  
[Academic title and name of committee chair]  

[Chair’s department]  
 

 

[Abstract text, double-spaced, left-aligned.]  

 

 

 

 

 
Instructional information is placed in brackets [ ] to help you format your document.  

Note that the wording on your page must be exactly the same as that in the sample.  


